Instructors Guide

On the following pages is a
sample module from our
Instructor Guide. It provides the
instructor with a copy of the
material and a Lesson Plans
box.

The key benefit for the trainer is

the Lesson Plan box. It provides O
a standardized set of tools to E_
assist the instructor for each

lesson. The Lesson Plan box

gives an estimated time to

complete the lesson, any

materials that are needed for

the lesson, recommended

activities, and additional points

to assist in delivering the

lessons such as Stories to Share

and Delivery Tips.
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Befae the beginning of great brilliance, there must
be chaos. Before a brilliant person begins somethin

great, they must look foolish in the crowd.
Lao-Tsu

Sample Module : Create and Manage Worksheets and Workbooks

Worksheets live in workbooks in Excel and create the building blocks of documenting, analyzing,

manipulating, and presenting data. This module will help you get started by creating workstmeiet

g2NJ 06221ad ,2dQfft Fftaz tSINYy Kz2¢ (2 yI@A3IFGS &2 dzN
Gr1S I £221 F4 F2NXYFOGGAY3 020K @g2N) akKSSaa FyR g2N.
options and views while working within Excel. Finghs Qf £ GF 1S I €221 +Fd RA&GNK
and workbooks via printing or sharing.

Create Worksheets and Workbooks

Estimated Timdor this

15 minutes
Lesson

9 Create a workbook
Topics in this Lesson 1 Import data from a delimited text file
I Add a workkeet to an existing workbook

Create a Workbook
A blank workbook allows you to start from scratch.

Topic Objective Create a blank workbook

When you first operexcel you can select a Blahkorkbookto start. You
Topic Summary can also select Blanworkbook by selecting the File tab to opéhe
Backstage viewthen selecthe New tab.

Materials Required Any Excel workbook

Recommended Activity | Have the participants create a new blank workbook.

Show the participants how to create a blank workbook. Usefttiowing procedure.

1. If the Backstage view is not showing, selectfiletab from the Ribbon. Selebtew.
2. From theNewtab, or if you have just opened Ex@€I16 selectBlank Workbook
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Book3 - Excel Michele Wiedemer 7 = O *
-
New
Open Search for online templates pel
Foz Suggested searches:  Business  Personal  Industry  Financial Management Lists Logs Calculator
-

Save As
Save as Adobe
PDF A B c

] >
Print 2 It

; Tak
Share 4 daKe a Make your first

5 .
opor ‘ tour PivotTable

7
Publish Blank workbook Welcome to Excel PivotTable tutorial
Close hd

Open a Comma Separated Values File
Many programs and serviceiaav you to create or download a comma separated values (or CSV) file

that contains your data. Excel can open these files.

Topic Objective Open a CSYV file in Excel

Topic Summary Open CSYV files from the Backstage View as if it was an Excel file.

Materials Required G{FYLXS /{+x¢ TFAES

Recommended Activity | Have the participants practice opening a CSV file.

Delivery Tips The CSV format is retained unless the file is saved as an Excel workbo

Show the participants how to open a comma separated values file

1. Select theFiletab to open the Backstage view.
2. SelectOpen
3. SelectBrowse
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©

Open

New

Sample CSV - Excel

Michele Wiedemer 7

@ Workbooks  Folders
Recent
Open
Today =
Save ® .
& Shared with Me Eamplceey 11/27/2017 2:05 PM
" C: = Users » mbwie » Dropbox » 1 Projects » CTM » Excel 201..,
Save As
Learning De5|gner post 11/27/2017 2:33 AM
Save as Adobe 6 OneDrive - Personal C: » Users = mbwie » Dropbox » 2 Areas = Blogs
PDF mbwiedemer@yahoo.com Yesterday
habit tracking
= 11/26/2017 %:40 PM
Lot E‘D This PC C: = Users » mbwie » Dropbox » 2 Areas » VCL Time Earnings... 20
oy
Share Emj“ats e Drombo s Arese s VO Time 11/26/2017 7:20 AM
+ Add a Place : » Users » mbwie » Dropbox » 2 Areas » ime Eamnings...
Export Older
sample chart )
Publish Browse @ C: » Users » mbwie » Dropbox = 1 Projects » CTM » PPT 2016... RN/ T2
Losb 2017 stat =
4. Navigate to the location of the file you want to import.
5.al 18 &dNB Ay GKS hLSy RAFt23 62E (2 OK22a$8 a!
list.
*
1+ <« mbwie » Dropbox » 1Projects » CTM » Excel 2016 Essentials » Sample files v O Search Sample files »
Organize « MNew folder
[ Desktop Ll MName Date modified Type 3
& Downloads fi] Sample CSV 11/27/2017 202 PM  Microsoft Excel C...
@ Documents
&=/ Pictures b
& Google Drive #
@ B-Module®
@ 2013 Resources
o Bxcel 2016 Essen Select a file to preview.
2 PPT 2016 Essenti
Microsoft Excel
2# Dropbox
f@ OneDrive
[ ThisPC
. v >
File name: || | Text Files ~
Tools = Open - Cancel

6. Highlight thefile you want to open and sele@pen
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Add a Worksheet to An Existing Workbook
Workbooks can be made up of more than one sheet, which can be useful as you get into more advanced
data analysis.

Topic Objective Add a worksheet to an existing workbook

Sheets are shown as tabs at the bottom of the Excel window. Select the

Topic S -
opc Summary sign to add another sheet.

Materials Required GvdzA Ol !'ylrftearaég alyYLXS FAES

Recommended Activity | Have the participants practice adding a sheet to the workbook.

Show tte participants how to insert a new worksheet. Use the following procedure.
1. Click the New Sheet plus sign at the bottom of the window.

H oS- alysis ved Mic emer

Add-ins ACROBAT \s_,-{) Share

Q Tell me what you want to do

Insert Page Layout Formulas Data QuickBooks

&D (}6 Calibri - - A == = - E—F‘ General ,_:J‘ ’—;j E‘“Insert - Z - %Y p
Paste o B 7 u-|m.l & ===e3= 4 y | €0 o Conditional Formatas Cell B Delete - | - Sort & Find &
@ ‘. =Tl=T A E=s=sx4d- = e Formatting - Table~ Styles~ EIFnrmat' T Filter~ Select~
Clipboard Font [F] Alignment [ Number [F] Styles Cells Editing ~
G12 - F v
A B C D E B G H J K L M N |~
1 |Company Industry Q1 Sales Q2 Sales
2 |A. Datum Corporation Tech 5195,449 $746,907
3 |Adventure Works Travel $123,721 $733,396
4 |Blue Yonder Airlines Travel $934,763 $246,554
5 |City Power & Light Utilities $299,293 $674,295
6 |Coho Vineyard Beverage 5228,783 $659,385
7 |Contoso, Ltd Misc $239,219 $287,989
8 |Contoso Pharmaceuticals Medical 5371,570 $644,368
9 |Consolidated Messenger Tech 5579,825 $448,399
10 |Fabrikam, Inc. utilities $639,630 $635,474
11 |Enurth Coffas Bayeraos 4276 740 4567 21R hd
Sheet1 | ® I »
Ready HH - + 100%

Excel opens the new worksheet to the first cell, so that you can begin entering data right away.

Hd - quick analysis - Excel Michele Wiedemer B
Inset  Pagelayout  Formulss  Data  Review  View  Adc-ins  ACROBAT  QuickBooks Q@ Tellmewhat youwant to do
AD?’ Calibri "o KA General ,_:.'4 Q %‘””‘E" Tz ’%Y p
B - BX Delete - | [0~

Paste L B I u- B O-A- ES- § -0 s <3 Condiional Formatas Cell . . _ Sot& Find&

- Formatting~ Table~ Styles~ P Format Filter = Select =

Clipboard Font Number Styles Cells Editing A
AL . # v

A 8 c D E F G H J K L M N 0 €[~

(1 —

2

3
4

5

6

7
8

9
10
1 -~
Sheet! | Sheet2 ® 1 3

Ready iz m - ¥ o
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Navigate in Workboo ks and Worksheets

Estimated Timdor this .
20 minutes

Lesson

9 Search for data within a workbook

1 Navigate to a named cell, range, or workbook element
Topics in this Lesson I Insert and remove hyperlinks

I Hide or unhide columns and rows

I Hide or unhide sheets

Search for Data

148 9EOStQa aSIHNODK FSFGdzNB (2 FAYR aLISOAFTAO

Topic Objective

Search for text or numbers

Topic Summary

You can search within a single worksheet or the entire workbook using
Find and Replace dialog box. Sel€ad & Select from the Home tab on th
Ribbon. Select Find. Open the Options to choose how to search for you
data.

Materials Required

GvdA O]l !'ylrftearaég al YLXS FAES

Recommended Activity

Have the participants practice finding text.

Delivery Tips

The Imustry column in the sample file makes a good practice for finding
ALISOATAO GSNY 6fA1S a¢SOKE 2NJ ad
within the whole workbook vs. the individual sheet.

Show the participants how to search for text or nunmbéar a workbook.

1. Select theHometab on the Ribbon.

2. SelectFind & Sel
3. SelectFind

© Carporate Training Material

ect

www.corporatetrainingmaterials.com

=N
w
"

[atN


http://www.corporatetrainingmaterials.com/

H ©- H quick analysis - Excel Michele Wiedemer O
Insert Page Layout Formulas Data View Add-ins ACROBAT QuickBooks Q Tell me what you want to do |&2 Share
-y R - -
B ot BTy =_ ®- 5  Genenl =:¢ =2 ’;j %mlnsert > ,% p
Past @- Iy C d' | Fi pt Cell & Delete - . Sort & Find &
aste B I U- i+ . === S A A ] onditional Farmatas Cel e ort & Fin
- o 4 . Formatting~ Table~ Styles - [=] Format - 7 Filter
Clipboard Font ] Alignment [F] Number ] Styles Cells Editi s
B9 ~ fe || Tech v
A B ) D E B G H 1 K -
1 |Company Industry Qlsales Q2 sales
2 |A. Datum Corporation Tech 5195,449 §$746,907
3 |Adventure Works Travel $123,721 $733,396
4 |Blue Yonder Airlines Travel $934,763 $246,554
5 |City Power & Light Utilities $299,293 $674,295
6 |Coho Vineyard Beverage $228,783 $659,385
7 |Contoso, Ltd Misc $239,219 $287,989
2 |Contoso Pharmaceuticals Medical 5371,570 5644,368
9 |Consolidated Messenger Tech $579,825 $448,399
10 |Fabrikam, Inc. Utilities $639,630 $635,474
11 |Enurth Coffes Beyerage 4876 74N 4567 21R hd
sheetl | Sheet2 | Sheetl (2) ® 1
Ready H O - + 10

4. In theFind and Replacdialog box, enter the text or numbers you want to find.

Find and Replace ? *
Find Replace
Find what: Tech v
Options =>
Find All Close

5. To search the entire workbook, select Options and select Workbook from the Withpndadmvn

list.
Find and Replace ? *
Find Replace
Find what: Tech £ Mo Format Set Format.. -
Within: | Workbook |~ ] Match case
EI Match entire cell contents
Search: | By Rows ~
Lookin: |Formulas ~ Options <<
Find All Find Mext Close

6. SelectFind Nextto find each instance individually. Sel&@hd Allto see a list of locations where
the item is found.
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Navigate to a Named Cell
Complicated workbooks may make use of Names to refer to a specific cell or cells. Thdi&@ogTwox
can help you navigate to that location.

Topic Objective Use the Go To dialog box

The Go To option is under tfeénd & Selectool on theHometab of the

Topic S . . : . .
Opic summary Ribbon. Th&o Taodialog box includes a list of named locations.

Materials Required GvdzA Ol !yl fearaég alYLXS FAES

Have the participants practice using the Go To dialog box to locate a na

Recommended Activity
range of cells.

Show the participants how to navigate to a named cell.

Select theHometab on the Ribbon.

SelectFind& Select

SelectGo To

Select the named reference from the list of locations.

pPwODbNPE

GoTo ? *

Go to:

SAS2

SCS7

‘[quick analysis.xls¥]Sheet1 [2)'1SCST
02 _Sales

Reference:

a2
Special... Cancel

5. SelectOK

The named reference is highlighted.
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Insert and Remove Hyperlinks
Hyperlinks provide a clickable shortcut to another location.

Topic Objective Insert a hyperlink

Use the Insert tab on the Ribbon and the Link tool to link to another pla

Topic Summ
GRS STl the worksheet, workbook or anywhere on the web.

Materials Required GvdzA Ol !'ylIfearaég alYLXS FAES

Have the participants practice insertingdgylinks. Have the participants

Recommended Activity . . .
practice removing a hyperlink.

Show the participants how to insert a hyperlink .

1. Select the cell where you want to create a link to another location.
2. On thelnserttab of the Ribbon, seledtink

H - s quick analysis - Excel Michele Wiedemer @ = O
File Home Page Layout Formulas Data Review View Add-ins ACROBAT QuickBooks Q Tell me what you want to do & Share

Al = -2 u 12 Line [ Slicer £y O

7] D =S il Store I ? N - . (;‘N I lr@ o '\TGEJ 4 -

° : bR R e i Column B3 Timeline
PivotTable Recommended Table  lllustrations 3 My Add-ins - E Recommended . _ Maps PivotChart 3D Link Text  Symbols

PivotTables - Charts " T |_ - >L\ - - - Map ~ ]IWmeoss - - -

Tables Add-ins Charts ra Tours Sparklines Filters Links ~

3. Selectinsert Link

Recent ltems

% Insert Link...

4. Adialog box appears allowing you to link to:
a. An existing file or web address
b. Another place in the current document
c. An entirely new document
d. An email address
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Insert Hyperlink ? *
Link to: Text to display: ScreenTip...
ﬁ Lookin: Sample files | |2 fa
Existing File
or Web Page B quick analysis Bookmark...
current | 4t cample CSV
= Falder
]
Place in This
Document Browsed
Pages
Create New Recent
Document Files
Address: v
E-mail
Address
OK Cancel

5. Enter the address to link to, or browse for a link destination.
6. Add or modify the text to servas the link in théext to Displayfield.
7. SelectOK

Insert Hyperlink ? *
Link to: Text to display: |Q2_Sales ScreenTip...
E Type the cell reference:
Existing File a1
or Web Page
Or select a place in this document:
= =) Cell Reference
Place in This
Document - 'Sheet1 (2)
=) Defined Names
Sheetl (2)'102_Sales
Create New B ()2 Sales
Document w
E-mail
Address

The text is colored and underlined to indicate a link.

A B C D E [ G H ] K
2 |A. Datum Corporation Tech 5195,449 $746,907 Q2 Sales
3 |Adventure Works Travel 5123,721 $733,396
4 |Blue Yonder Airlines Travel 5934,763 $246,554
5 |City Power & Light Utilities $299,293 5674,295
6 |Coho Vineyard Beverage $228,783 $659,385
7 |Contoso, Ltd Misc $239,219 $287,989
8 |Contoso Pharmaceuticals Medical $371,570 5644,368
9 |Consolidated Messenger Tech $579,825 $448,399
10 |Fabrikam, Inc. Utilities $639,630 $635,474
11 |Fourth Coffee Beverage 5876,740 5567,216
12 |Granhirc Nesian Institite Eduratinn 4788 390 4540 782
Sheetl | Sheetl (2) ® [l

Show the participants how to remove a hyperlink.

1. Right click on the hyperlink.
2. SelectRemove Hyperlinkrom the context menu.
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-Y- Cut
By Copy
ry Paste Options:

iy

Paste Special...
,(D Smart Lockup
Insert...
Delete...
Clear Contents
B Quick Analysis
Filter 3
Sort 3
¥ Insert Comment
Format Cells...
Pick From Drop-down List...
Define Mame...
& Edit Hyperlink...

Open Hyperlink

@R Remove Hyperlink

The text remais but the link is removed.

Hide or Unhide Columns and Rows
You can temporarily hide information in your worksheet to help you limit what is shown or printed.

Topic Objective Hide and unhide columns and rows in a worksheet

Select the row ora@umn you want to hide. Righdlick and select Hide from
the context menu. A double line is placed in the column or row referenc
Topic Summary show that a column or row is hidden. To restore the hidden information
the current view, rightlick the column or rowfger the missing item (or
select multiple columns or rows) and select Unhide.

Materials Required GvdzAi Ol !ylItfearaéd alyYLIES FAES

Have the participants practice hiding columns and rows. Have the

Recommended Activi . . o
ty participants practice unhiding columns araivs.

You can hold down the Shift key to select congruent multiple columns ¢
Stories to Share rows to hide more than one at a time. You can hold down the Control kg
to select multiple rows or columns that are not next to each other.

Show the participnts how to hide columns.

1. Highlight the column(s) you want to hide.
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quick analysis - Excel Michele Wiedemer &

Formulas Data Review View Add-ins ACROBAT QuickBooks Q Tell me what you want to do

E © 2 I=- - @ T Line B Slicer T o
,:'9 S| Wl Store 1? = &y, I “@“ & 4 Q
; . : W~ Ti- — i Column = Timeline 4
PivotTable Recornmended Table llustrations & My Add-ins - Recommended ) _ Maps PivotChart 3D - Link = Text Symbols
PivatTables - Charts @~ b B < Map~ | [ Win/Loss - - -
Tables Add-ins Charts & Tours Sparklines Filters Links A
Bl ~ 3 Industry v
A B c o | E | F & | H | 1 | 3 | x | L | M | N
1 |Company Industry Q1 sales Q2 sales
2 |A. Datum Corporation Tech 5$195,449 §$746,907
3 |Adventure Works Travel $123,721 $733,396
4 [Blue Yonder Airlines Travel $934,763 $246,554
5 |City Power & Light utilities $299,293 $674,295
6 |Coho Vineyard Beverage 5228,783 $659,385
7 |Contoso, Ltd Misc $239,219 $287,989
2 |Contoso Pharmaceuticals Medical $371,570 5644,368
9 |Consolidated Messenger Tech $579,825 $448,399
10 | Fabrikam, Inc. Utilities $639,630 $635,474
11| Enurth cnffes Reverase 4R7A 740 45A7 21A -
Sheet] | sheet1 ) | & < v
Ready Average: 537177.8667 Count 32 Sum: 8057668 HH /|- 1 + 100%
2. Right click and selegtidefrom the context menu.
6 Cut
By Copy
&D Paste Options:
il
Paste Special...
Insert
Delete

Clear Contents

Format Cells...

Unhide

The information is hidden and a double line indicates the missing columns.

quick analysis - Excel Michele Wiedemer =

Home Page Layout Formulas Data Review View Add-ins ACROBAT QuickBooks Q@ Tell me what you want to do & Share

= =t h i i a

E‘? D =2 ol store I@ [} II-vI::v Q | |@I E;‘”‘e I?:"e" % 4 Q
PivotTable Re(.ommended Table llustrations .‘Myﬁ.dd—ms ,E Re(ommended', :f ;:’ Maps PivotChart ED] ]éwoumn e Link Text Symbols

PivotTables - Charts LT T - Map ~ " Win/Loss - - -

Tables Add-ins Charts ! Tours Sparklines Filters Links ~
Bl ~ £ || Industry v

AIIDIE‘FIG‘HI‘JIKILIMINIOIPIA
1 |Company Q2 Sales
2 |A. Datum Corporation $746,907
3 |Adventure Works $733,396
4 [Blue Yonder Airlines 5246,554
5 |City Power & Light 5674,295
6 |Coho Vineyard 5659,385
7 |Contoso, Ltd $287,989
2 |Contoso Pharmaceuticals 5644,368
S |Consolidated Messenger $448,399
10 |Fabrikam, Inc. 5635,474
11 | Enurth raffes 457 21A A
Sheetl | Sheetl (2) | ® [ 3

Ready Average: 537177.8667 Count: 32 Sum: 8057668 H O - 1 + 100%
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Hide or Unhide Sheets
Entire worksheets can also belben.

Topic Objective

Hide worksheets in a workbook

Topic Summary

To hide a worksheet, right click on the worksheet tab at the bottom of th
window and select hide from the context menu. To unhide a worksheet
right-click on a visible worksheet and selémhide from the context menu
The Unhide dialog box allows you to choose which worksheet to unhide

Materials Required

GvdzAi Ol 'yltearaé alYLXS FALS 064

Recommended Activity

Have the participants practiceding a worksheet. Have the participants
practice unhiding a worksheet.

Show the participants how to hide a worksheet.

1. Right click on the tab you want to hide at the bottom of the Excel window.
2. SelectHidefrom the context menu.

Insert...
L_‘X Delete
Rename
Move or Copy...
(;TJ View Code
[ Protect Sheet...
Tab Color 3

Select All Sheets

The worksheet tab is moved from the bottom of the Excel window.

Ready

Sheetl

)

Show the participants how to unhide a worksheet.

1. Right click on any tab at the bottom of the Excel window.
2. Select Unhide from the context menu.
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Insert...

Delete

Rename

Move or Copy...
View Code

Protect Sheet...
Tab Color 3

Hide

Select All Sheets

3.

-

Unhide

Unhide sheet:

*

Sheetd

Cancel

4, SelectOK

Ho o -

Insert

Page Layout

Formulas

Data

Review

In the Unhidedialog box, select the sheet you want to restore.

quick analysis - Excel Michele Wiedemer =

View

Add-ins

ACROBAT

QuickBooks

Q@ Tell me what you want to do

O

& Share

“D ‘X) Calibri M — = ¥~ =3 Currency - D @ %“Insert P %Y p

By - ! - £ Delete - - ’

e (BT [E- (oA B e Toe~ Syjes- | EIFomats | @ P St

Clipboard Font ) Alignment [F] Number ) Styles Cells Editing LS

02_sales  ~ F || 746907 v
A | B | 19 D E | [? | G | H | | 1 | I | L | N~

2 |A. Datum Corporation Tech $195,449 $746,907

3 |Adventure Works Travel $123,721 5733,396

4 |Blue Yonder Airlines Travel $934,763 $246,554

5 |City Power & Light Utilities $299,293 $674,295

6 |Coho Vineyard Beverage $228,783 $659,385

7 |Contoso, Ltd Misc $239,219 $287,989

8 |Contoso Pharmaceuticals Medical $371,570 $644,368

9 |Consolidated Messenger Tech 4579,825 5448,399

10 |Fabrikam, Inc. utilities $639,630 $635,474

11 |Fourth Coffee Beverage 5876,740 $567,216

12 | Granhir Nasion Institute Eruratinn 4728 390 4540 782 -
Sheet1 | Sheetl (2) ® [l »

Ready Average: 550,372 Count: 15 Sum: 58,255,581 B Mmoo 1 + 100%
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Modify Worksheets

Estimated Timdor this .
20 minutes

Lesson

 Insert and delete columns and rows

9 Adjust row height and column width
Topics in this Lesson i Insert headers and footers

1 Change worksheet tab color

f Rename worksheet

Insert and Delete Table Rows and Columns
Edit your worksheets by inserting and deleting rows and columns.

Topic Objective Insert and delete rows and columns

ThelnsertandDeletetools on theHometab of the Ribbon allow you to
add or remove rows andotumns to your current worksheet.

Topic Summary Select a row or column next to where you want to insert cells. The curs
changes to a small arrow when you point to an entire row or column. S¢
Insertfrom the Hometab on the Ribbon and selekitsert Sheet Rowsr
Insert Sheet Columns

Materials Required GvdzAi Ol !'yItearaég alyYLIES FAES

Recommended Activity | Have the participants practice inserting and deleting rows and columns

Show participants how to add a new row. Use the following procedure.

1. Highlight the row belw where you want to insert a row. Click to the left of the row number to
highlight the whole row.
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2. Selectinsertfrom the Hometab on the Ribbon.
3. Selectinsert Sheet Rows

H ©-¢&- = quick analysis - Excel Michele Wiedemer 3] m}

Insert Page Layout Formulas Data Review View Add-ins ACROBAT QuickBooks @ Tell me what you want to do | Share

‘.D 3‘; Calibri S KA == =3 General - D ’_? 2~ %Y p
B - = & Delete -~ [~
Paste ” B I U-~ &y . A === e=3= E - $ v 0 9 <8 o Condltl.onal Format as  Cell y Sort & Find 8
= Formatting~ Table~ Styles~ I fe-Formot ¥ F\ferl Select =
Clipboard Font ] Alignment ] Number ] Styles Cells Editijg -
A6 = fe | Coho Vineyard v
A B C D E F G H J K L M |«
1 |Company Industry Q1 Sales Q2 Sales
2 |A. Datum Corporation Tech $195,449 $746,907
3 |Adventure Works Travel $123,721 $733,396
4 |Blue Yonder Airlines Travel $934,763 $246,554
5_.City Power & Light Utilities $299,293 $674,295
= |Coho Vineyard ‘Beverage |  $228,783 $659,385
77| Contoso, Ltd Misc $239,219 $287,989
8 |Contoso Pharmaceuticals Medical $371,570 $644,368
9 |Consolidated Messenger Tech $579,825 $448,399
10 |Fabrikam, Inc. Utilities $639,630 $635,474
11 |Enurth Coffes Beverage 487/ 740 45R7 21A -
Sheet! | sheeti 2 | @ 1 v
Ready Average: 444084 Count:4  Sum: 888168 HH - ] + 1003

The blank row is added above the selected row. It is highlighted and reaggudo add text.
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